SpinalMOD User Manual
Written by: Elizabeth A. Gozal
Please give Elizabeth credit when using SpinalMOD.  Thank you!

SpinalMOD is currently unsupported and is being made available ‘as is’.  
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1. What is SpinalMOD?

SpinalMOD (Spinal Motor Output Detector) is a MATLAB Graphical User Interface (GUI) for the analysis of locomotor-like activity.  It is a simple yet rather comprehensive single-screen GUI designed to be simple so that it can be operated easily by users who are not familiar with programming languages.  SpinalMOD can open data from the following file formats, .abf, .xls, .xlsx, and .mat (see Opening the data).  Up to four channels of data can be imported and compared at one time. The raw data is rectified and processed through a low-pass Chebyshev filter.  The burst threshold is calculated, and a series of IF-THEN logic statements evaluate whether specific criteria are met.  SpinalMOD determines the beginning and end of the bursts being analyzed and calculates bursts statistics, such as period, burst duration, and phase.

2. What is needed to run SpinalMOD?
An up-to-date version of MATLAB is necessary in order to run the SpinalMOD GUI.  The following files must also be located in the same directory:

1) SpinalMOD.fig
2) SpinalMOD.m
3) readabf.m 

It is simplest to put them into the MATLAB file in My Documents.  If, however, you decide to place them into a different directory, you will need to change the path to the files.  This can be done by finding the Current Folder at the top center of the MATLAB window.  Click on the … button and select the folder in which you placed the files.  After you have set the folder initially, you can select the downward arrow button to return to a path you have previously selected. 
3. Appearance of the GUI
3.1. GUI sections

SpinalMOD is broken into 3 major sections (Figure 1): 
1) On the left is the Variables Section, which displays the variables that the user can change to detect the bursts (For definitions of the burst see Definitions of the variables).  
2) In the middle is the Waveform section, where the traces are loaded and the detected bursts are displayed.  The raw trace is green.  The rectified and filtered trace is black.  The stems marking the beginning of a burst are red, and the stems marking the end of a burst are blue.  Once the burst analysis has been performed, the bursts that were analyzed are demarcated with a dashed black stems.  
3) To the right is the Burst Analysis section, where burst statistics and characteristics are displayed (For definitions of the burst analysis see …).
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Figure 1: SpinalMOD Graphical User Interface.  
The graphical user interface is designed to be easy to use.  The input variables are listed to the left under VARIABLES for all four channels.  To change the variable, the user simply clicks inside the white box and changes the value.  The waveforms for the data are show in the middle.  Raw data is in green.  Filtered data is in black.  The stems marking the beginning of a burst are red, and the stems marking the end of a burst are blue.  If the stems are not in the correct location, the user changes the variables and selects “Run with Updated Variables” as many times as the user deems necessary.  If the algorithm fails to find the correct beginning and end for the bursts, the stems can be manually changed with the “Change On/Off Stem Marks.”  To run the burst analysis, the user would push the “Run Burst Analysis” button, and select first the number of bursts to analyze and then the first burst to analyze.  Dashed black stems mark the beginning and end of the analyzed period.  Once analyzed, the values calculated are shown in the Burst Analysis section to the right of the GUI.


3.2. GUI buttons

There are 3 buttons located at the top of the Waveform section (Figure 1):

1) Run with Updated Variables (See Running the burst detection with updated variables)

2) Change On/Off Stem Marks (See Manually changing stems marking the bursts)

3) Run Burst Analysis (See Running burst analysis)

3.3. GUI menu structures

3.3.1. Menu bar
When SpinalMOD is first opened, there are a series of menus in the top left hand corner.  There are three first level menus, namely “File”, “Edit”, and “Settings”.  The “File” menu offers options to open data, save analysis, open figures into a pop-up window for closer examination, and for exporting analysis.  The “Edit” menu offers the ability to undo and redo changes in variables. 
(I plan to add a return to default values for the variables option too.)
The “Settings” menu offers options to change the file name, change channel names, set the sample frequency of the data being analyzed, and change how the burst threshold is being calculated.  Once an option has been selected, most options have a pop-up window that guides the user through the desired action.
3.3.2.  Waveform context menus

By right clicking in the white area in each of the 4 waveforms in the middle of the GUI, there are 4 different changes that can be made to the appearance of the waveforms:
1) Change the x-axis values displayed allows the user to change the x-axis range displayed in the GUI.  MATLAB is a little finicky regarding the times displayed in the graphs in the GUI.  It is easiest to load durations that are 0-20, 24, 28, 30, 32, 36, values between 40-120 that are divisible by 10, values between 140-240 that are divisible by 20, 280, 300 etc.
2) Change the y-axis values displayed allows the user to change the y-axis displayed in the GUI.
3) Change vertical offset allows the user to change the vertical offset of the black rectified and filtered trace compared to the y-axis.
4) Change black marker height can be used by the user once the Burst Analysis has been run.  It allows the user to change the heights of the dashed black stems demarcating the bursts that were analyzed.

3.3.3. Burst Analysis context menus

For the lower three graphs in the Burst Analysis section, when the user right clicks in the white area in the graphs, the user can select the graphs to be displayed.  There are 6 different choices:

1) Power Spectrum Graph

2) Average Waveform Graph

3) Change in Period Graph

4) Change in Burst Duration

5) Change in Duty Cycle Graph

6) Change in Peak Height Graph
4. Open and run the SpinalMOD GUI
Type SpinalMOD (I will need to save the one we publish on the website as this; however, for now you actually need to type in SpinalMOD_L16 to reflect the version currently being used.) into the Command Window and press enter.  This will open the GUI and the user can immediately start using it. 
5. Open the data
The data is loaded through the File menu by selecting Open (Ctrl + O) and choosing the file to be analyzed from the location it has been saved.  
It should be noted that the default sample frequency is 5000 Hz. If the user has a different sample frequency, it needs to be changed prior to opening the data.  This can be done under settings in the menu bar or the default value could be changed if the user regularly uses a different sample frequency (Change the default sample frequency).
5.4. File Formats that can be opened into SpinalMOD

Three different file formats can be opened for analysis:

1) The first file format is the .abf, which was recorded using pCLAMP acquisition software (v8-9, Molecular Devices; Union City, CA).  This data is inputted into SpinalMOD via a custom script written by Michael Sorensen, called readabf.m.  The .abf must be saved in the ABF 1.8 (integer) (*.abf) format.
2) The second file formats are .xls and .xlsx, which are files from Excel.  If the data was not recorded in pCLAMP, it can be saved in Excel.  In order for SpinalMOD to be able to read the Excel sheet, the data must be arranged such that all of the data is on the first worksheet.  Each channel must be a different column and the first line of the column is the name of the channel (Figure 2).  
3) The third file format is the .mat, which is the form data that has already been analyzed in MATLAB is saved.
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Figure 2: Formatting an Excel spreadsheet.

In order for SpinalMOD to recognize the data in an Excel spreadsheet, the data needs to be put into the first worksheet, each channel of data must be in a different column (i.e. – Columns A-E), and the first line of the column needs to be the name of the channel (i.e. – Row 1).


5.5. Choices when opening the data

There are a number of choices to make as the data is being loaded:

1) Does a stimulus artifact need to be removed from any of the channels?  
a. If the answer is yes, the user will be further asked: Which channel is the trigger channel? 

i. Trigger channel is defined as a channel that records when the stimulus artifact happened.  The baseline is zero, and if there is a stimulus there is another value (ie - 1 or 10) to indicate the stimulus.
ii. SpinalMOD does not support removal of the stimulus artifact if there is no trigger channel.   If there is no trigger channel, SpinalMOD will continue to open with the stimulus artifact.  The user can select: There is no trigger channel.  However, to go through the questions more quickly, it is recommended answering no instead to the question: Does a stimulus artifact need to be removed from any of the channels?
b. If the answer is no, the user will proceed to the next question.

2) Please select up to 4 channels to be analyzed:  The user can select which channels to load.  A minimum of 1 channel and a maximum of 4 channels can be loaded.  
3) Please enter the names of the channels: The user can enter the names of the channels.  For example, pCLAMP may name the channel IN1, but what was being recorded was the left lumbar 2 ventral root (l-L2).  Here the name could be changed from IN1 to l-L2 or IN1: l-L2.  
4) Change the order of the channels.  For example if IN1 is l-L2 and IN4 is r-L2, then reordering the channels so that the L2s are right next to each other may make sense.  
5) Select the data to be opened and displayed in the GUI.  There are 3 questions being asked to open the data appropriately in the GUI.  The questions pertain to all of the data being opened.  If the data is not opened at this time and the user wants another portion of the data opened later, the file will need to be reopened at that time.  After the data is open, the user can select the portion of the data to be analyzed from the Waveform context menus.  
a. 'What start time from the opened file do you want?  For example, if there are 300 seconds in the user’s file and the user wants to open from 100 to 200 seconds of data from the file, the start time would be 100 seconds.
b. How many seconds of data would you like to open?  Using the same example as above, the number of seconds to open would be 100.
i. MATLAB is a little finicky regarding the times displayed in the graphs in the GUI.  It is easiest to load durations that are 0-20, 24, 28, 30, 32, 36, values between 40-120 that are divisible by 10, values between 140-240 that are divisible by 20, 280, 300 etc.  The same is true when changing the x-axis values displayed.
c. What start time do you want displayed in the GUI?  Again using the example above, the user could choose 100 as the start time to be displayed and 100 to 200 seconds would be on the x-axis.  If the user were to choose, 0 instead, the times displayed on the x-axis would be from 0 to 100 seconds. 
5.6. Problems opening the SpinalMOD GUI

1) Any data reduction in pclamp will prevent it from opening in SpinalMOD.  (I am planning on adding an option to reduce data points in SpinalMOD, it will add a question to the above sequence.)
2) Filtering reduces number of data points so you won’t be able to open the full range that is prompted in the display (e.g.- it might say 300 seconds but only 299.9 seconds are available).  The user can open the data by changing the parameters when opening the data.
6. Run the burst detection
As the data is loading, the first run through of the burst detection is calculated.  For each channel, the raw data is rectified and processed through a low-pass Chebyshev filter.  The burst threshold is calculated (See >>>>>>>), and values above the threshold go through an algorithm using the input variables on the left side of the GUI to calculate the beginning and end of each burst.

Once the data has been opened and has gone through the first calculation, the user can change the input variables and select the “Run with Updated Variables” button to rerun the detection algorithm to correct the burst analysis output. The user changes the variables and selects “Run with Updated Variables” as many times as the user deems necessary. 
If the algorithm is unable to detect the beginning and end correctly, typically due to noise or a poor signal to noise ratio, the user has the option to manually place the markers indicating the  beginning and end of a burst (See Manually changing the stems marking the bursts).  
6.7. Definitions of the variables
The Variables Section displays variables the user can change to detect the bursts.  These variables are (Figure 1 and Figure 3): 

1) Amplification

2) Analysis Start Time (s) is the time in seconds that the user wants the GUI to start searching for the beginning of the first burst to be detected and later analyzed.  

3) Min. Period (s) is the minimum period in seconds between the beginnings of each burst.  

4) Min. Burst Duration (s) is the minimum time in seconds of the burst duration.  

5) Min. InterBurstTime (s) is the minimum time in seconds between the end of one burst and the beginning of the next burst.  

6) Min. Ringing Time (s) is a variable to prevent early detection of the end of the burst.  Since the algorithm examines the array point by point, this variable is the minimum time in seconds after the offset has been detected that there cannot be another offset detected.
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Figure 3: SpinalMOD terminology.
A.  A graphical representation of 1st Burst’s Start Time, Period, Burst Duration, and InterBurst Time are shown.  As a reminder, the stems marking the beginning of a burst are red, and the stems marking the end of a burst are blue.  B. The min. ringing time variable was implemented to prevent early detection of the end of the burst.  While many points may fit the other criteria for being the end of the burst, ringing time helps to ensure that the last of these points is selected.  Shown here are 4 points that fit the other criteria for the end of the burst.  If the time of the Min. Ringing Time is not long enough (left) then the wrong point is marked as the end of the burst.  When it is long enough (right), the correct point is marked.  B is a zoom in of the offset for the first burst in A.


7. Manually change the stems marking the bursts

 If the algorithm fails to find the correct beginning and end for the bursts, the stems can be manually changed with the “Change On/Off Stem Marks.”  When the button is pushed, there is a series of pop-up windows to direct the user.  The user can pick the channel he/she would like to edit, whether he/she wants to move, delete, or add a stem, and whether he/she wants to move a red onset stem or a blue off stem. 
8. Run burst analysis
Once the burst markers correctly mark the beginning and end of each burst, the user can select the “Run Burst Analysis” button, and the burst characteristics will be calculated.   The user provides the number of bursts to be analyzed and the first burst to be analyze.  The analysis analyzed the bursts after the first burst selected only.
Dashed black stems mark the beginning and end of the analyzed period.  Once analyzed, the values calculated are shown in tabular and graphical form the Burst Analysis section to the right of the GUI. A phase plot figure as well as three of six other graphs, (average waveform, period, peak height, duty cycle, burst duration, and power spectrum), can be chosen for display.
 The burst analysis calculates frequency, average period, average burst duration, average duty cycle, mean peak-to-peak amplitude, mean peak amplitude, relative modulation amplitude, the phase between the different channels, the power spectrum, and the average waveform Kjaerulff and Kiehn 1996()
.
9. Open figures into pop-up windows
If the user wants to look at any of the graphs in the GUI in more detail, they can be opened into a pop-up window.  Prior to the burst analysis, only traces in the Waveform section can be opened.  The user will be given similar choices to when opening data into SpinalMOD (Choices when opening the data).  There are similar limitations for the times that are displayed on the x-axis.  However, it can be noted that if the user is saving the figure for use in another program, the x-axis from another saved file without the limitations could be used to create an accurate x-axis (see Figure 4).   The figure that pops up is formatted such that the channels are listed in the top left corner (Figure 4).  The top two traces correspond to the first channel listed, and the bottom two traces correspond to the second channel listed.  Within the pair, the top trace is the rectified and filtered trace, and the bottom trace is the raw trace.
After burst analysis has been run, the user will have eight options for types of pop-up windows: waveforms, phase plots, power spectrum, average waveform, changes in period, changes in burst duration, changes in duty cycle, and changes in peak amplitude.  When opening the phase plot, the user will have an additional choice of which phase comparison’s the user would like opened.  
9.8. Edit the pop-up window figures

To further edit the pop-up windows, click on the Show Plot Tools and Dock Figure icon (marked by the red arrow in Figure 4A). Clicking on the icon will bring up the plot tools, shown in Figure 4C.  There are numerous changes that the user can make. 
1) Making Changes to the axes and traces

a. There are two ways to make changes to the axes and traces

i. The first is to use the Plot Brower panel to the right.  The user can turn the axes and traces on/off by clicking the check boxes.  Also, by clicking on the labels, this will bring up changes that can be made in the Property Editor in the bottom panel.
ii. The second is to click on parts of the actual figure.  Make changes to the axes by selecting the white box.  Make changes to traces by selecting the individual changes.  Options for changes will be brought up in the Property Editor in the bottom panel.

b. Changes to the axes and traces can be found in the Property Editor in the bottom panel
i. Changes that can be made to the axes include the title, background color, font color, adding a grid, labels for the axes, values for all axes, and font.  

ii. Changes that can be made to the traces include display name, line style, line size, line color, axis, etc.  
2) Making changes to the legend

a. A legend can be added by clicking the Insert Legend icon (marked by the blue arrow in Figure 4A).  
b. Existing legends can be edited by clicking on the legend in the figure.  
c. There are option to change the location of the legend, colors, and fonts.  To change the words in the legend, click on More Properties, which is to the right.  In the inspector box that pops up, click on the yellow square next to string.  The names can be changed in the box that pops up. Close the windows when done.  

After the user is done making changes, he/she can hide the plot tools by clicking the Hide Plot Tools icon (marked by the green arrow in Figure 4A).  
9.9. Save the pop-up window figures

Don’t forget to save any changes that have been made.  To do so, click the File and then Save As.  Under Save as type the user will have a list of options for what file type they would like to save the figure as.  If the user thinks that he/she may want to go back and edit the figure at all, I would recommend saving two copies of the file: one as the MATLAB figure (*.fig) and one as your file type of choice.  The .fig will allow the user to edit the figure at a later time. 
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	Figure 4: Pop-up window figures

A. The channels are listed in the top left corner of the pop-up window.  The top two traces correspond to the first channel listed, and the bottom two traces correspond to the second channel listed.  Within the pair, the top trace is the rectified and filtered trace, and the bottom trace is the raw trace.  The traces are 50 seconds in both A and B.  The x-axes are correct in A, while they are wrong in B.  A corresponds to 0 to 50 seconds of the opened file, while B corresponds to 5-55 seconds of the opened file.  Unfortunately, this is a defect in MATLAB.  If the trace is saved for use in another program, the axis could be corrected.
C. To make changes to the figures in MATLAB, the user should click on the Show Plot Tools and Dock Figure icon (red arrow in A).  Clicking on the icon will bring up the plot tools, shown in C.  The user will be able to change colors, axis, etc.  


10. Save the burst analysis
The data is saved through File menu by selecting Save (*.mat) (Ctrl + O) OR Save As (*.mat).  If the file has not been saved before when Save is selected, the Save As pop-up window will appear.  The user can change the filename, which will automatically be the file that was opened unless the title/filename was changed under settings.
11. Export Data

11.10. Export Data to Excel

The user can export the data that was calculated during the burst analysis to Excel.  This is done through the File menu by selecting Export Numerical Data to Excel.  The values that are exported are frequency, average period, average burst duration, average duty cycle, mean peak-to-peak amplitude, mean peak amplitude, relative modulation amplitude, the indices for burst on and burst off, the peaks, the troughs, and the phases.

**A current limitation of MATLAB is that when saving to an excel spreadsheet, there is no way to set the pathway (ie – the folder in which you want the spreadsheet to be located).  Therefore, it will automatically save the excel spreadsheet to the current folder.  It can be moved after it is done being exported.
11.11. Export Data to the workspace

The user can export the data that was calculated during the burst analysis to the workspace.  This is done through the File menu by selecting Export Numerical Data to Workspace.  The window that pops up will have check boxes in the left column.  When checked, the variable will be exported to the workspace.  The middle column is what values will be exported.  In the column to the right are the names that the values as they will appear in the workspace once exported.  These names can be changed by clicking on the white box and typing.  
12. Edit the SpinalMOD code to fit the user’s needs better
There are two parts of SpinalMOD: SpinalMOD.fig and SpinalMOD.m.  Different aspects of the GUI can be edited in each of these parts to change SpinalMOD to fit the user’s needs better.  Generally, SpinalMOD.fig will edit the appearance of the GUI and any changes will be automatically reflected in the associated SpinalMOD.m file.  SpinalMOD.m is the “meat” of the GUI.  It is where the code to run callbacks and any functions is located.  

Changes to the default settings should be made when the user will be using the new settings consistently.  Most of the changes listed below have an option for changing it in the program on an individual basis.

12.12. Changes to SpinalMOD.fig in the layout editor

SpinalMOD.fig will edit the appearance of the GUI and any changes will be automatically reflected in the associated SpinalMOD.m file.  There are very few changes that the user will likely make to this section, especially if the user has limited experience with MATLAB, since the appearance of the GUI is pretty well set.  The Automatically resize the SpinalMOD GUI is highly recommended however.

To make changes to the SpinalMOD.fig portion of the code, type guide('SpinalMOD.fig') and press enter.  This will open the SpinalMOD.fig file, and the user will see a blueprint of the SpinalMOD GUI.  To run the GUI from the GUIDE Layout Editor, press the green triangle Run Figure or “play” icon.  The button is on the right side at the top of the grey section.  A new window that is the GUI will appear, and the user can start using it.  If no more changes need to be made to SpinalMOD, the user can now close the pervious “blueprint” window.  

12.12.4. Automatically resize the SpinalMOD GUI 

In order to activate the option to automatically resize the SpinalMOD GUI to fit whatever size window the user is using, go up to the top of the .fig blueprint, select the Tools menu, and then select GUI Options.  In the first window, set the Resize behavior to Proportional and press OK.  You should only have to do this once.

12.13. Changes to SpinalMOD.m in the editor
SpinalMOD.m is the “meat” of the GUI.  It is where the code to run callbacks and any functions is located and most changes to default settings will be made.  There are two ways to open the SpinalMOD.m file in order to edit it:

1) Open the SpinalMOD.fig (Changes to SpinalMOD.fig in the layout editor), right click in any blank area in SpinalMOD.fig, and select Editor, which will open up the editor.  
2) Open the folder where SpinalMOD.m is located and click on SpinalMOD.m.  This will open the file and MATLAB if it isn’t already open.  In order to run the GUI, press the green triangle on what looks like a white piece of paper icon also called Run SpinalMOD.m (F5).  The button is in the middle of the top grey section.
Once the editor is open, the user can search for specific code and then edit it appropriately.  There are two ways to pull up the Find & Replace box:

1) Ctrl-F and type or copy (Ctrl-C) and paste (Ctrl-V) the information listed below into the Find what box.  This is my preferred way to search.

2) Edit>>Find and replace and then type or copy (Ctrl-C) and paste (Ctrl-V) the information listed below into the Find what box.

Below, the above process is referred to as finding the code.  The places in the code listed below where the changes to the code will take place are marked with stars (*****).
**An important note for those unfamiliar with programing, anything that is listed after the % symbol and is in green is a comment.  Comments are not read by the program when it is running.  The purpose of a comment is to explain the code or how to use the code more clearly.

12.13.5. Change the default sample frequency

The default sample frequency is 5000 Hz.  If the user’s sample frequency is different, the change can be made in the initialization section of the SpinalMOD code.  Find the code DO NOT EDIT THE CODE ABOVE THIS POINT!.  The line the user wants is a few lines later, handles.sampfreq=5000;.  Change the 5000 to the user’s sample frequency.
To find the sample frequency in Clampfit, File>>Properties, then look for the Sampling rate.

12.13.6. Change the values of the default variables in the GUI
Find the code, function InitiateVariablesInGui(hObject, eventdata, handles)

This function sets the default values for the six variables (see Definitions of the variables) used to calculate the beginning and end of the bursts for each channel.  
The variable names in the code are listed below:
1) Amplification is listed as handles.Amplification#
2) Analysis Start Time (s)  is listed as handles.BurstStart#
3) Min. Period (s) is listed as handles.MinPeriod#
4) Min. Burst Duration (s) is listed as handles.MinBurstDur#
5) Min. InterBurstTime (s) is listed as handles.MinInterBurst#
6) Min. Ringing Time (s) is listed as handles.EndMin#
Note the # symbol indicates the channel number.

For example, the code currently is: 

set(handles.Amplification1, 'String', num2str(20));
The default value in this example is 20, if the user wants the amplification to be 15 instead of 20, the line of code would look like this instead:

set(handles.Amplification1, 'String', num2str(15));
12.13.7. Change the default burst threshold 
Currently there are three different ways to calculate the burst threshold:

1) Mean of the whole trace

2) 50% of the max value of the whole 

3) 30% of the max value of the whole trace
The default selection is for the first option.  To change the default value, find the code DO NOT EDIT THE CODE ABOVE THIS POINT!.  The line the user wants is a few lines later, handles.BurstThreshChoice=1.  Change the value to either 2 or 3.  If the user wants 2, then the line would look like this instead:
handles.BurstThreshChoice=2.
12.13.8. Add more options for calculating the burst threshold

In order to add more options for calculating the burst threshold, there are 3 locations in the code that the user should visit.

1) The first and the more important is to find the code:
function BurstThresh=CalculateBurstThreshold(filtered, BurstThreshChoice)  Here the user must add the actual code that calculates the burst threshold.  The user should follow the directions in the code and keep the formatting similar to the formatting of the current three options.  Filtered is the array being inputted into the function, and is the rectified and filtered values.  The final result should look similar to what is written below, but with the right half of the second line as the new formula.
elseif BurstThreshChoice==4
    BurstThresh= ceil(0.5*mean(filtered,2)*10)/10;

2) There is a portion of the code under Settings>>Burst Threshold Calculation where the different options are listed and can be selected for an individual instance.  To add the newly added function, find:

function Menu_Settings_BurstThresh_Callback(hObject, eventdata, handles)
Here the new options should be added to the end of the options line:

options={'Mean of the whole trace'; '50% of the max value of the whole trace';'30% of the max value of the whole trace'}; 

It should look similar to:
options={'Mean of the whole trace'; '50% of the max value of the whole trace';'30% of the max value of the whole trace'; 'name of new option'}; 

3) If the user wants to make the new option the default, follow the direction above (see Changing the default burst threshold) to make it the default.
12.13.9. Change defaults for the questions asked while the data is being opened
12.13.9.1. Change the default answer for whether a stimulus artifact needs to be removed
One of the questions when opening the data is:

Does a stimulus artifact need to be removed from any of the channels?
The current default answer to this is No.  However, if the user is regularly opening file where the stimulus artifact does need to be removed, it would be convenient for the default to be Yes instead.  There are two lines of code written into the program already.  Find the code:

StimButton = questdlg(prompt,'Stimulus Artifact?','Yes');

If the user wants to default to be Yes, then he/she needs to comment out the No line and comment in the Yes line.  This would look like:

StimButton = questdlg(prompt,'Stimulus Artifact?','Yes');

%StimButton = questdlg(prompt,'Stimulus Artifact?','No');

Instead of the way it is now, where No is the default:
%StimButton = questdlg(prompt,'Stimulus Artifact?','Yes');

StimButton = questdlg(prompt,'Stimulus Artifact?','No');

12.13.9.2. Change the default answer for which channel is the trigger channel

One of the questions when opening the data is:

Which channel is the trigger channel?

The current default answer is the last channel that is read into the program.  However, if the user wants to set a different channel as the default, the code needs to be changed to reflect the desired channel.  To do so, find the code:

prompt='Which channel is the trigger channel?';
The user will change the default answer to reflect number that the channel was read into the program.  For example, assume that there are three channels read into the program in the following order:  IN1, IN3, IN2.  

The current default code would highlight IN2 to be selected.  However, if the user will consistently want IN3 to be selected, the code will need to be changed from: default=length(FieldNames);
to

default=2;

12.13.9.3. Change the default answer for selecting channels to be opened
One of the questions when opening the data is to:
Please select up to 4 channels to be analyzed:
Currently, if there are 4 or less channels, the default answer is to select the all of the channels.  If there are more than 4 channels, the default answer is the first 4 channels.  To change, find the code:
'Please select up to 4 channels', 'to be analyzed:'

The user should follow the directions in the code as to how and where, but variable InValue should be changed to equal the channels that the user wants highlighted as the default channels.
12.13.9.4. Change the default answer for the names of the channels

One of the questions when opening the data is to:
Please enter the names of the channels:
The default answer is what the names the channels were named when the file was opened.  To change this, find the code:

Change the default names of channels:
ChannelNames is the variable that names the default names in the pop-up window in the GUI.  There are three different options listed in the code as to how to change the default channel names.  

1) The names that are read in while the file was being opened are used.  This is the current default.

2) Both the names that are read in while the file was being opened and a more descriptive name are used.

3) A more descriptive name for each channel is used.

Details on implementing each are given in the code.

12.13.9.5. Change the default answer for the order of the channels

One of the questions when opening the data is:
If you would like to change the order, please indicate the new order below:

The current default is to keep the channels in the order in which they were read into the program.  To change that, find the code:

To change the default channel order change the numbers in the

Then change the order of the numbers in the following code:

ChannelOrder={'1';'2';'3';'4'};
The number need to be 1-4, in whatever order the user wants them to be.

12.13.9.6. Change the default answers for what portions of the data will be opening from a file
Find Opening data into the GUI.  Immediately below it is the line with the default values for the questions asked when opening the data into the GUI (see 5 in Choices when opening the data). 
12.13.10. Changing the default values for the opening the waveform figures into a pop-up window
Find %Get parameters so the figure can be graphed into a pop-up window
The default values are currently set to be the whole portion of data that was opened up.  If however, the user regularly opens up the same portion of data, it makes sense to set exact values.  For example, the user may want to open 50 seconds of data, but keep the rest same.  The user could change the code to:
12.13.11. Changing the default for which variables to export to the workspace
function Menu_File_ExportToWorkspace_Callback(hObject, eventdata, handles)
selected= logical([1 1 1 1 1 1 1 1 0 0]);
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